Help for ircle 2.0

This is ircle, a Macintosh-based, windowed user interface to the Internet Relay Chat (IRC) network.
This window contains:
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. General notes, Copyright Notice
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0. Brief Overview on IRC

(If you know IRC, skip this section)

IRC is a multi-user online chatting system. It allows users to talk to other users all around the world via the Internet.
This is done by connecting a client program (such as this one) to a server. You need a connection to any network
connected to the Internet and running TCP/IP, and the MacTCP network driver. You have to select your preferred
server (usually the nearest), using the popup menu in the Preferences dialog. The port number used by IRC servers
is usually 6667.

On IRC, users are identified by nicknames of their own choice. Nicknames may be at most 9 characters long. The
nickname is set via preferences or the NICK command (see below). If you choose a nickname already in use, you
have to set a different nick. Some users have registered their nicknames with the NickServ database. If you get a
message from NickServ that your nick is in use, please choose another.

Communication on IRC is done via Channels and Private Messages. Channels have names starting with # (public
channels) and & (local) and usually up to 12 characters long. You can see a list of the channels currently in use via
the /LIST command. As soon as you join a channel with the /JOIN command, everything you type is sent to that
channel and seen by all other users on that channel. You will see what the others type, respectively.

1. ircle Basics and Windows

ircle has a user interface similar to the traditional text-oriented IRC clients. If you know IRC, you will find it familiar. At
the bottom of the screen is the input line in an own small floating window which also carries a line of status
information. Everything you type will appear in the input line. When you press Return, the line gets sent to the current
channel or, if it contains a command, that command is processed. A line is considered command if it starts with a '/’
(slash). You can change this character with the /ICMDCHAR command. See Section 2 on commands.

You connect to the server via Open conection in the File menu. When the connection to the server is established, the
main message window will appear. This window has your nickname in the title bar.

As soon as you join a channel, a channel window will appear with the channel name and topic as its title. All
communication done in that channel will appear in that window. If you close this window, you leave the channel.

Querying a user (see below) will open a user window. All private messages from and to that user will appear in this
window.

You can switch between windows using the mouse or aE™-, (comma) key. The destination of text that you type is
always determined by the frontmost window, i.e. the text goes to the channel or user whose name is the frontmost
window's title.

The number of windows open at a time is limited only by your computer's memory and your capability of listening at
many sources at a time :-)

All messages not coming from or related to a channel or queried user will appear in the main message window. That

can include long lists from certain commands. You can skip these by pressing aE"-. (dot).

You can arrange the channel windows using aE"-1 (Tile Windows, all channel window's size are adjusted so that
they are completely visible), or the Stack Windows (all windows are put on top of each other, showing only the title
bars).

2. IRC Commands and ircle Menus



Traditionally, IRC is controlled by typing commands. A line starting with a slash (/) is considered a command. ircle has
implemented this behaviour instead of a mouse-driven environment for simplicity and user-interface compatibility to
other IRC clients. The topic of a channel (shown in the title bar) can be changed by double clicking in it, though.
Certain frequently used commands can be reached via menus. These, however, do just paste the commands into the
input line and thus are shortcuts for typing the commands.

The File menu has items for opening a connection, closing the topmost window (this will leave a channel), setting
Preferences, opening/closing a logfile and the Quit command.
The Edit menu has the Copy and Paste items. Text in a window can be selected and copied, then pasted into the

input line.

The Commands menus contain selected IRC commands. They get just pasted into the input line and are shortcut for

convenience.

The Shortcuts menu provides a means for user-defined shortcuts. They can be defined in a dialog box and called via

aE"-o through 9. Note that new settings work only after closing the definitions dialog.

The Font menu lets you set your preferred font and size. This will affect the currently active window and all new
windows opened afterwards. It also gets stored in the Set file.

The Windows menu contains the titles of the active windows for fast selection.

Preferences settings

Preferences settings are stored in the ‘ircle preferences' file inside your Preferences folder in the System Folder.

The settings in the General Preferences dialog are:

Server: The server you want to connect to. This has to be a numeric IP address or a full host.domain name.
Port: Usually 6667, when in doubt check with your server administrator.

Nickname: The nickname you want to start with.

Mail address: You should specify your login name or mail address on a fully qualified (with domain) machine.
Real name: Your real name (or whatever evil thing you want to look like your real name)

Noatifications: when messages appear in an inactive window, or in any window while ircle is running in the
background, you will get alerted by a sound and/or blinking menu bar item, as you can select by checking these

boxes.

Indentation: causes channel text to be indented for clearer reading.
Auto DCC: enables the automatic opening of a DCC CHAT window, or automatic DCC receiving of files.

The settings in the Color Preferences dialog are:

Colors: sets various message and window colors. Click on a color box to change it.

Sounds: enables sound to be played when people sign on and off, are being kicked, when MODE changes appear
and when NOTIFY find a person coming on or offline.

Description of IRC Commands

The following commands are currently available: (x) = untested.

/admin nick

/admin server
/away message

/bye message
/broadcast message
/channel channel
/cmdchar ¢

/cping nick

/ctcp target command
/date

/dcc command nick
/exit message
/ignore pattern

shows administrative info

marks you as being away (no message = not away)

displays message and quits IRC

sends a message to all of your windows

join a channel

changes the command-prefix (default /) to the given character
shows response time for nick

issues a CTCP command. Do /ctcp target clientinfo for more info.
display date and time

issues a DCC command (explained below)

= /bye

ignore messages from nick!user@host (may contain wildcards)



+pattern
-pattern
/info
/invite nick channel
/join

/join channel
/kick channel nick
/leave channel

/links

/list
-min n
-max n
-public
-private
-local
-global
-topic

/lusers

/map

/me action
/mode channel parm
+p
+s
+1
+m
+n
+t
+1 #4#
+v nick
+b nick
+k key
+o0 nick
-x
/mode nick parm
+1i
+s
+w
/motd [server]
/msg nick message
/names channel
/nick newnick
/note
/notice
/notify
/notify nick
-nick
/part channel
/query nick
/quit message

/server hostname [port]

/silence
/silence mask
/signoff message
/stats

b

c

ignore and give the ignored a notice

removes a pattern from the ignore list

gives info about server

invites nick to channel

joins channel last invited to

= /channel

kicks nick from channel

leave a channel

show server connections

list channels

list only channels with minimum of n users
list only channels with maximum of n users

list only public channels

list only private channels

list only local channels

list only global channels

list only channels with topic set

display statistics

displays a map of all server connections

sends an action description

set channel mode:

private channel

secret channel

invite-only channel

moderated channel

no messages from outside channel

only channel operator may set topic

channel may hold at most ## users

let nick speak on moderated channel

ban nick

set channel password

nick becomes channel operator

removes flag x, where x is one of the above

set user mode:

invisible user

receive server notices

receive wallops

show message-of-the-day [of another irc server]

sends nick a private message
listusers on channel
change your nickname
unknown

(almost) like /msg

show notify list

adds nick to notification list (show each signon/off)

removes nick from notification list
= /leave

open window for private messages to nick
= /bye

switch to a different server

show ignored users list

ignores users with selected mask
= /bye

show statistical info:

shows ban list

shows list of connections
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/summon user@host
/time
/topic channel text
the same)
/trace [user]
/type
/users
/version
/wallops message
/who channel
/whois
/whois nick
/whowas nick

IRC Operator commands:

/connect
/die

/hash
/host
/kill nick
/oper
/rehash
/restart
/squit
/uping

Valid commands for /dcc are:

?
)

shows list of operators
2

2

shows server uptime

2

invites user@host to IRC (host must be running a server)

= /date

set a channel topic (double clicking in the title bar of a channel lets you achieve

shows which servers are being used to connectto user

type a text file to the current channel

(%)

show server version

message to all operators (deprecated)

list people on channel

give information about nick that last joined the channel or sent private message
give information about nick

give information about nick no longer online

* connect two servers

* shut down a server

* reconfigure a server

(x)

* kicks nick out of IRC

* become operator

* reconfigure a server

* restart a server

* eemove a link between servers
* unknown

chat - requests CHAT connection for nick or answers such a request.
send - send afile.

tsend - send a text file.

get - receive a file (to be answered to a SEND request).

tget - receive atextfile.

list - listall DCC connections.

3. Hints & Advice

More information on IRC commands can be found in the ‘ircle Users manual’ and 'IRC Advice' files and probably in
the help files for the IRCII client (but note that IRCII has a number of commands for programmability that ircle has

not).

When selecting a hon-proportional font keep in mind that IRC was originally designed for text terminals and some
commands and messages assume a fixed-size screen. That may make output look strange in some situations.



This client uses the ISO Latin-1 8-bit character set and converts Macintosh special characters to this code. Some
characters can not be converted and will be mapped to nonsensical Urs. This also holds for DCC tsend/tget which are
text-mode versions of send/get. The conversion table are those also used by Peter Lewis' FTPd.

New users should check the file 'IRC Advice'.

4. General notes, Copyright Notice

This program was written by Olaf Titz (s_titz@ira.uka.de), July 1992-July 1993. You may use, copy and distribute it
under the terms and conditions of the GNU General Public License, see the file COPYING that should have
accompanied this program. Be sure to include the file COPYING when distributing this program.

Some parts of this program written by Peter N. Lewis, (©) 1992.
Written and compiled using THINK Pascal 2.0.1, thus Portions Copyright (©) 1988 Symantec Corp.

This program was modified by Onno R. Tijdgat (tijdgat@knoware.nl), September 1994-January 1995 using Think
Pascal 4.0.2.

Copyright (©) 1994-95 Olaf Titz/Onno Tijdgat

THIS PROGRAM IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND
FITNESS FOR A PARTICULAR PURPOSE.

System requirements: any Mac with System version 7.0 and the MacTCP driver.

This client is to fit version 2.7, 2.8 and Undernet servers. All commands and features obsoleted by 2.7 are taken out
(as should be all obsolete servers by now). This client is fully compatible with the RFC1459 (IRC) & RFC 1430 (Ident

service) documents.

Have fun!



